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LEGAL DISCLAIMERS AND IMPORTANT INFORMATION, PLEASE READ BEFORE 
INSTALLING THE SUPERCHARGER SYSTEM!! 

- Use extra caution when driving any modified vehicle. Increased power may 
produce increased speeds that may make the vehicle unsafe or uncontrollable 
and result in serious injury or death. We do not condone speeding or breaking 
any traffic laws. It is the responsibility of the purchaser, owner or operator of the 
vehicle being modified with this supercharger system to understand all risks 
associated with increasing the horsepower of a vehicle and to obey all local 
traffic laws. 

- Overkill and its partners are not liable for any damages as a direct or indirect 
result of installing this supercharger. The purchaser, installer or reseller of this 
supercharger system cannot, under any circumstances, hold the companies 
mentioned liable for any subsequent loss, damages, fines or penalties. It is the 
responsibility of the purchaser, owner or operator of the vehicle being modified 
with this supercharger system to understand all risks associated with increasing 
the horsepower of a vehicle. 

- This supercharger system is NOT CARB approved and is not legal for use on 
any public roads in the state of California. This system has not undergone any 
approval for use on public roads. Despite all efforts to ensure no increased 
emissions from normal vehicle operation, this system may not meet your local 
emissions laws. It is the responsibility of the purchaser, owner or operator of the 
vehicle being modified with this supercharger system to understand and comply 
with all emissions laws associated with their vehicle. 

-  Use of 91 octane or higher is REQUIRED with this supercharger system. Do not 
use 87 octane, 89 octane, or E85 ethanol fuel. For all forms of racing or 
sustained high speed use, it is recommended to use a mixture of 100+ octane 
unleaded race fuel and the highest octane pump gas available. It is HIGHLY 
RECOMMENDED to use the computer tuning services provided by Overkill or 
the installer of this system to ensure the safe and proper operation of the engine 
with this supercharger installed. Your provided Autocal or HP Tuners can provide 
scans for the owner/operator of the vehicle to view. It is the responsibility of the 
purchaser, owner or operator of the vehicle being modified with this supercharger 
system to understand all risks associated with increasing the horsepower of a 
vehicle, and to understand for themselves how to identify unsafe and improper 
vehicle operation which may lead to engine damage. 

- Installation of this system by a trained certified mechanic is HIGHLY 
RECOMMENDED. It is the responsibility of the purchaser, owner or operator of 
the vehicle being modified with this supercharger system to ensure the safe and 
proper installation of this system to avoid damage to any of its components which 
may not be covered under warranty due to installation error or abuse. 



Installation Overview 
 
Step 1: Remove Front Bumper 
Step 2: Remove Air Filter Assembly 
Step 3: Remove Power Steering Reservoir and Install New Reservoir 
Step 4: Remove the Power Steering Oil Cooler and Install New Cooler 
Step 5: Install Crankshaft Pulley and Adjust Lower Coolant Hose 
Step 6: Install 2008-2009 Accessory Kit (if applicable) 
Step 7: Install Tensioner To Mounting Plate 
Step 8: Install Mounting Plates and Vortech Unit 
Step 9: Install Throttle Body Spacer 
Step 10: Install Front Mounted Intercooler and Prep For Intercooler Tubing 
Step 11: Install Drivers Side Intercooler Tubing 
Step 12: Install Passenger’s Side Intercooler Piping 
Step 13: Install Intake and Air Filter 
Step 14: Install Horns and if applicable Computer Bracket 
Step 15: Spark Plugs and MAP Sensor 
Step 16: Install Catch Can 
Step 17: Reinstall Front Bumper 
Step 18: Fill With Oil and Final Checks Under The Hood 
Step 19: Flash Tuning File 

Before you start doing the installation, you must first read the factory tuning from 
your vehicle to send to Overkill so that I can begin to write your new tuning while 
you’re doing the installation. Do NOT make this the last step and then be concerned 
when you’ll get the new tuning back because the car isn’t drivable after the install 
without it, do this first!  

Disconnect your battery before starting the installation. Remove the negative 
battery terminal and place a clean towel on the battery post to prevent contact.  

From your parts store, you will need 500ml to a quart of power steering fluid 
applicable to your year CTS, check the owner’s manual. 

Recommended items to have: Blue Loctite, Dielectric Grease, WD40, Spark Plug 
Gapping Tool, Electrical Tape, A Sharp Razor Blade, Drill, 3.5” Hole Saw, Allen 
Socket and Torx Socket Bits for 3/8” Rachet, Torque Wrench, Full Socket Set, 
Sturdy Scissors, Tub to catch oil that will drain, Zipties 

 

 



Before You Begin: Install Your Tuning Software and Read the Factory Tuning 

In the HP Tuners kit is a USB stick, and on it is the software to install on your PC You 
can also find the HP Tuners software on their website which will be their most up to date 
versions and may be the best way to go, you can find it at 
www.hptuners.com/downloads Download the “Download VCM Suite: Latest Full 
Version” in the upper left, and if you need them you can also download the MPVI2 
Drivers on that page. Plug your HP Tuners MPVI2 module into your PC using the USB 
cable, install the software. Next, open VCM Editor, go to Help > Resync Interface, and 
that’ll pole the module for your licensing information that has been preloaded; you may 
need to be connected to the internet. Ok, ready to go to the vehicle. 

Using the HP Tuner MPVI2 module and supplied USB cable, connect to your vehicle’s 
OBD2 port below the dash. Turn the key or ignition to “on” or “run”, so the instrument 
cluster lights up, but do NOT start the engine. If you have a push button start, press and 
hold the start button with your foot off the brake pedal for about 10 seconds to put the 
vehicle into run mode. Wait 20 seconds from turning the ignition on before you begin a 
read of any of the computer modules, to allow them time to boot up and run their startup 
system checks. Turn the radio off and the HVAC system off to conserve battery power, 
you can also turn off the headlights if its dark out. 

In the VCM Editor program, to go Flash > Read Vehicle; in the popup window that 
opens, click the Gather Information button.  

 

http://www.hptuners.com/downloads


Once it poles the vehicle, you’ll see a new pop up window with options to read the 
various computers that are supported. Always have the engine ECM computer at the 
top set to Read Entire, and if you’re an automatic transmission you’ll want the 
transmission TCM computer set to Read Entire. If you see an option for the FSCM 
which is the fuel pump computer, set this to Do Not Read unless you have instructions 
otherwise from me.  

 

With those set, click Read and let it do its thing, the read will take typically 3-5 minutes. 
Once completed, save the file as your name, your vehicle, and “factory” or “stock” so 
you know that this was your factory computer tuning should you ever need to access it 
again. Email the file that you just saved to willoverkill@gmail.com.  

 

mailto:willoverkill@gmail.com


Step 1: Remove Front Bumper 

Let’s get the hard part out of the way and remove the front bumper and the inner 
fender skirts to give room to work. Follow the location references in these following 
images to remove all the screws and trim parts required, and finally remove the front 
bumper fascia. 

 

 

 

 



 

 



Step 2: Remove Air Filter Assembly 

Onto an easier task, remove the factory air filter system, or whichever aftermarket 
system you may have. We’ll outline the factory system, but refer to your aftermarket 
manufacturer’s instructions as needed. Remove the engine cover to start. 

Unhook the breather tube from the air tube and follow it back to the rear of the 
engine to remove. Loosen the the clamps at the throttle body and air cleaner and 
remove the tube. Unplug the MAF sensor. Remove the one bolt on the strut tower 
behind the filter housing, and then the housing will pull straight up and out of the 
vehicle.  

If you have a 2012-13, remove the two torx screws and remove the MAF sensor 
insert to reuse. For all 2008-2011 models, you don’t need to remove the MAF as the 
kit will have come with a new 2012-13 model of MAF. For 2010-2011 3.0 models, 
you’ll have a MAP sensor looking device on your air cleaner housing, you’ll want to 
remove it from the housing and ziptie it somewhere secure either now or towards the 
end of the installation, simply leaving it open to free air. 

 

 

 

 

 

 

 



Step 3: Remove Power Steering Reservoir and Install New Reservoir 

Let’s remove the power steering fluid reservoir, as we’ll be relocating it with our new 
kit. Ideally you’ll want to suck the fluid out of the reservoir, but you can also 
disconnect the smaller hose carefully and drain the reservoir, then tip the hose over 
to drain as it’ll be full of fluid as well. The reservoir is held on with two bolts; once 
drained, remove the bolts and remove the reservoir. Follow the large hose down the 
power steering pump, loosen its clamp and remove the hose. 

 

 

 

 

 

 



The new reservoir mounts back beside the brake fluid reservoir. The black bracket 
and its aluminum sub bracket goes over the stud and is secured by the same nut. 
The reservoir then slides down onto the black bracket. You’ll need to use a little 
persuasion on the A/C line to give the reservoir some clearance. 

Run the new larger hose from the new reservoir to the power steering pump and 
secure with the two new clamps provided. You can run the smaller hose from the 
reservoir following the A/C lines through the headlight area to the front bumper, in 
preparation for the next step.  

 

 

 

 

 

 

 

 

 

 

 

 

 



Step 4: Remove the Power Steering Oil Cooler and Install New Cooler 

The factory oil cooler is very large and located behind the front crash bumper. Start by 
disconnecting the lines by the radiator in the front fenderwell area. You’ll see clamps 
joining the cooler lines with a plastic joiner; you’ll want to loosen the clamps and remove 
this joint, you’ll be coupling the new lines to what remains in the engine bay. Follow the 
cooler lines, remove a securing bolt on the side of the radiator. The cooler is held on by 
two bolts, one atop of the crash bar, and the other behind on the passenger’s side. 
Once loose, remove the cooler and catch any oil. 

 

 



Place the new cooler in the middle of the condenser and as high up as it will go. Use the 
included zip ties to attach the cooler to the condenser to your satisfaction. 

 

You can now secure the new cooler lines or leave it to later. You’ll be running the 
smaller hose from the reservoir through the headlight area to the top of the cooler, 
leaving enough slack to run around the impending supercharger bracket install. Cut the 
hose to length and secure with hose clamp provided. Next run the remaining hose from 
the lower cooler port to the hose in the engine bay you disconnected, using the included 
brass barb and hose clamps to secure. 

 

 



Step 5: Install Crankshaft Pulley and Adjust Lower Coolant Hose 

One of the harder parts of the installation will be removing the crank pulley bolt. Using a 
strong impact gun ideally, remove the bolt. The new pulley will index into the OEM crank 
pulley spokes. Once the new slip fit pulley feels slotted in and sits flush with the OEM 
crank pulley, install the new provided bolt and torque to factory specifications. Note the 
2008-2009 models will need to use the longer provided bolt and its washer, while 2010-
15 models use a new OEM bolt. 

 

You should now find that the lower coolant hose is either touching the crank pulley or is 
very close. This is corrected by loosening the upper clamp on the coolant hose, and 
grab and twist the hose on its metal neck until you see clearance from the crank pulley 
of at least a finger width. Reinstall the clamp to secure. Done. 

 



Step 6: Install 2008-2009 Accessory Kit (if applicable) 

If you have a 2008-2009 CTS, you have a little extra work to do. Using the accessory 
kit, you’ll be replacing the upper coolant hose and relocating the brake vacuum pump. 
You may wish to remove the intake manifold to help with access to everything. 

Start by removing the upper coolant hose clamps and hose, catching the coolant that 
will spill. Next, locate the bolts and remove the coolant neck that the hose attached to. 

Unplug the electrical connection and hose connection from the brake vacuum pump (the 
cylindrical device on the front of the engine on the driver’s side). You can next remove 
the two nuts and bolts fastening the pump to its bracket, followed by removing the 
bracket from the engine. 

Locate the new bracket in the kit, the two new bolts and two spacers. The larger spacer 
is a press fit into an existing large hole in the engine on the passenger’s side. Use the 
larger diameter bolt and fender washer to connect the bracket to this spacer, and using 
the slit to move side to side, use the smaller diameter bolt and spacer to line up to an 
existing bolt hole. Secure both bolts. 

Mount the brake vacuum pump to the new bracket. Use the rubber hose extension to 
cut and extend the existing hose to reach the new location. Use the provided wiring 
extension to reach the new pump location. 

Moving on to the coolant hose, the new coolant neck comes with new bolts and 
provided gasket. Ensure the surface its mounting to is clean and install. Use the clamps 
off of the old coolant hose on the new hose and install. 

Lastly, you may or may not have an electric auxiliary coolant pump at the bottom of your 
radiator that has a looping hose on it. We provide a more direct 90* coolant elbow to 
replace it if you need clearance from the crankshaft pulley. 

 

 

 

 

 

 

 



Step 7: Install Tensioner To Mounting Plate 

To prepare to install the mounting plates, first attach the tensioner assembly to the outer 
face plate with the Vortech attached. Referencing the Vortech, the tensioner body 
mounts on the pulley side of the plate, with the outside of the pulley facing the same 
direction as the Vortech pulley. Install the included 3 bolts and torque to 8 ft-lbs or 96 
inch-lbs with blue Loctite recommended. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Step 8: Install Mounting Plates and Vortech Unit 

Time to install the good stuff!  

Once installed, the plates will look similar this (5th Gen Camaro shown), OF COURSE 
YOU”LL HAVE THE PROCHARGER ATTACHED TO IT, but this gives you an idea of 
how the plates install… 

 

Identify first the components:  

#1 You’ll have the outer plate with the Procharger attached and tensioner now attached, 
#2 you’ll have the inner engine side plate, #3 you’ll have a block like bracket that goes 
behind the engine side plate to attach to the engine, #4 1 long round spacer with a 
larger inner diameter, #5 1 shorter round spacer with a larger inner diameter, #6 2 long 
round spacers with smaller inner diameter, #7 two medium hex head cap screws of the 
same length, #8 one medium-large hex head cap screw, #9 one large countersunk head 
screw, #10 one large hex head black color screw and #11 two smaller countersunk 
head screws. 

Blue Loctite is recommended on all of the following bolts. 

The sequence is important to ensure minimal curse words and disgruntlement, so follow 
along! 



You’ll start by bolting the #3 bracket to the side of the engine on the driver’s side. 
Removing the existing bolt by the oil filter, and use the provided longer bolt (#8) to 
secure the bracket, hand tight only. 

 

 



Grab the engine side mounting bracket. You’ll need bolts #10, #11 and #7 and spacer 
#5. Identify the backside of the plate, and slide bolts #7 through the two bolts at the top 
of the plate so they face forward.  

 

 



Using bolt #10 and spacer #5, slide the bolt through plate from the front side, then 
through the spacer, and attach to the existing threaded hole on the front of the engine, 
hand tighten the bolt. Rotate the plate until the countersunk holes and the threads in the 
#3 bracket line up, and use the #11 bolts to secure. Tighten the #10 bolt snug to line up 
the plate, then torque the #11 bolts to 15ft-lbs to connect the two brackets.  

Now the tougher part, use a ring wrench (a ratcheting one helps) to tighten the #8 bolt 
now that the brackets connected and aligned. It’s a tight fit sliding up from around the 
power steering pump, the right ring wrenches will make the difference between a 
difficult and an easy job. 

 

With the bolts tightened, remove the #10 bolt and discard, its job is done. Slide the #6 
spacers over the #7 bolts and ready the #4 spacer and #9 bolt.  

Time to slide the outer plate and the Procharger underneath the large A/C line to an 
adjacent position to the engine plate. Slide the #9 bolt through the outer plate, through 
the #4 spacer, through the engine side plate, through the #5 spacer and begin to tighten 
to the engine block. Rotate the backside of the outer mounting plate up to line up the #7 
bolts from the engine plate and begin to secure them with a ring wrench until snug. Go 
back to the #9 bolt, fully snug and torque to 35ft-lbs. You won’t really be able to torque 
the #7 bolts, ensure they’re snug and secure but do not overtighten. 



 

If you need to clock the Procharger, you’re able to move it be loosening the 6 small 
allen head retaining bolts and rotating the snail like outer housing. The outlet should be 
pointed straight down. 

 

 

 

 

 

 

 

 

 



Step 9: Install Throttle Body Spacer 

Before doing the intercooler tubing, good time to install the throttle body spacer. A 
throttle body spacer is provided to provide engine vacuum to the blow off valve and to 
the catch can system. Open the kit, it’ll have a spacer with fittings preinstalled, a gasket 
and longer bolts. Remove the throttle body by removing the 4 securing bolts. Install the 
spacer with the straight vacuum fitting and hose facing the passenger’s side of the 
vehicle, the 90* fitting will face upwards and towards the driver’s side. Using the longer 
provided bolts, secure the throttle body with the provided gasket between the throttle 
body and plate. The included ¼” hose will run to the blow off valve. 

 

 

 

 

 

 

 

 

 

 

 

 

 



Step 10: Install Front Mounted Intercooler and Prep For Intercooler Tubing 

Use a jack to slide the intercooler up behind the front crash support.  

Use the longer included bolts with spacers to secure the intercooler to the long leg of 
the L brackets and hang the short leg over the crash support bumper. It’s recommended 
you don’t yet secure to the crash support, in case you wish to slide the intercooler 
sideways one way or the other to help with fitment of the intercooler tubing. 

 

Prep to install the driver’s side tubing. The small transmission cooler and A/C lines 
along the driver’s side of the radiator will almost all need to be disconnected from their 
securing tabs in order to wiggle around and provide clearance. 

The lower transmission cooler line needs to be bent from its current 60* to a full 90* 
angle in order to provide clearance from the intercooler tubing. Pull its retaining clip with 
a pick and disconnect from the radiator, catch any fluid that drains. Using a pipe 
bending tool ideally but your hands carefully as needed, bend the existing bend until it’s 
a full 90*, then reinstall into the radiator and secure. 

 



If you have a 2010-2013 model with the engine computer in the fenderwell, remove the 
computer from its bracket by unclipping it at the top, and follow its wiring harness to 
unclip and move it out of the way. You’ll also want to remove the two nuts holding the 
bracket inplace, remove the bracket, then reinstall the nuts. Set the computer aside for 
now, it’ll be reinstalled later with its bracket in a different location. 

You may also find that this bracket that retainers the bottom passenger’s side corner of 
the A/C condenser may need to be removed to provide clearance to the intercooler. 

 

 

 

 

 

 

 

 

 

 



Step 11: Install Drivers Side Intercooler Tubing 

The following picture shows the driver’s side intercooler tubing. It’s a one piece design 
that will fit right from the Procharger outlet to the intercooler up front.  

To install, slide the long leg of the tubing up from the fenderwell area to the Vortech 
outlet (you may find spraying the exterior of the tubing with WD40 helps it slide up), 
ensure to have a clamp over the tubing before it goes over the Procharger outlet; have 
the intercooler side roughly lined up before tightening the Procharger side first, then with 
a clamp over the intercooler end slide it over its connection and secure. 

 

 



Step 12: Install Passenger’s Side Intercooler Piping 

Rear Wheel Drive Vehicles:  

Reference the following picture for a rough idea of how the tubing goes together: 

 

 



The sequence from the intercooler outlet will be the smaller Cobra head silicone elbow 
with its short side to the metal BOV T pipe, to the 90* side of the large preformed 
silicone tubing with the milder bending end to the smaller end of one of the multi-size 
90* silicone elbows (connected with the small metal joiner), to the mesh screen end of 
the MAF sensor housing, to the second unequal size elbows to the throttle body. The 
MAF sensor will take two of the larger clamps, with all other connections using the 
smaller clamps. 

Remember to use WD40 and spray the insides of the silicone couplers to help them 
slide onto the aluminum tubing and rotate easily. The WD40 will dry and not harm the 
silicone. 

Prep by installing the MAF into the MAF housing. If you have a 2012-13 model you’ll 
reuse your factory MAF sensor, otherwise use the new included card MAF sensor. Very 
important to face the MAF components the correct way. Locate the open end of the 
MAF sensor, this will face towards the end of the MAF housing that has the screen in it, 
and the screen end will point into the airflow with the open end facing the throttle body 
end. 

Slide the long preformed silicone tubing up into the engine bay from the passenger’s 
fenderwell, or you can go in from the engine bay, but either way have the 90* end in the 
fenderwell area. Assemble the Cobra head to the blow off valve tee pipe, and slide into 
the 90* connection of the preformed silicone tubing you just put in place, then connect 
over the intercooler outlet. Manipulate the connections as needed to get the tubing in 
the engine bay to be pointing vertical with its outlet facing towards you as you look into 
the engine bay from the front of the vehicle; don’t forget to use the rotation of the Cobra 
head silicone coupler as well as the travel on its connection to the BOV tee pipe to 
achieve the right fit.  

Assembly the one of the 90* multi-size elbows to the MAF sensor inlet (mesh screen 
side), slide its metal joiner into the other end of that elbow, try and make it as even as 
possible with how much is in vs how much sticks out, and use a clamp to secure; this 
will keep the joiner from sliding in and out of this elbow while you insert it into the other 
silicone connection. With a clamp in place over the preformed silicone tubing in the 
engine bay, slide the joiner into the tubing, position it so the MAF sensor is pointed with 
its outlet facing sideways towards the driver’s side of the engine bay, and secure its 
clamp before you put the last silicone piece on as you may find it hard to reach. Ensure 
you get the clamp high enough to get over the metal joiner and not slide off. Lastly put 
the last silicone coupler over the MAF and throttle body and secure with clamps. Once 
you’re happy with those connections, go back into the fenderwell and secure its clamps, 
all the tubing should now be installed and clamps tight. 



All Wheel Drive Vehicles: 

Your intercooler tubing is different, it will run up around the headlight area and you’ll be 
removing and relocating the washer fluid reservoir to fit the tubing.  

Begin by draining any fluid out of the washer fluid reservoir by removing the pump or by 
any other method of your discretion, then remove the bolts that secure and remove the 
factory reservoir. Next, remove the two nuts behind the crash bar to remove the large 
black metal bracket that was serving as the mounting bracket for the reservoir. Keep the 
nuts handy, you’ll need them again shortly. 

Remove the headlight to get room to work with. 

Locate the 90* silicone elbow (orange inside) that has a long leg but it shorter than the 
similar tube used off of the supercharger outlet, compare the two as needed to 
determine, longer used for Vortech outlet on the driver’s side, shorter is what you want. 
On this silicone elbow, install its longer leg to the intercooler and face its other leg 
pointed upwards and slightly backwards; to this connection you’re going to slide in the 
Vortech Blow-Off valve Tee fitting. Up in the engine bay, install the multi-size 90* elbow 
to the throttle body and install the MAF sensor housing with the screen facing the 
passenger’s side of the vehicle, we’ll build backward from these components. Connect 
the multi-size 45* silicone elbow to the MAF and point it between the fuse block and the 
radiator as shown in the pictures; to it you’ll connect the metal 45* elbow followed by the 
60* silicone elbow. This elbow should now reach the Vortech Blow-Off valve with correct 
manipulation of the connections. Temporarily install the headlight to check for fitment 
and clearance, and once satisfied begin to tighten up all the hose clamps you’ve been 
installing at each coupling; the two MAF connections will need the larger 100mm 
clamps, all others will need the smaller 87mm clamps. 

You’ll find a flat metal bracket in the kit, this bracket will bolt to the headlight and those 
two nuts behind the crash bar and give the headlight its anchor at that corner. Secure 
the headlight back in place using its fasteners and lastly secure the two nuts once 
aligned. 

The new washer reservoir will mount in the back passenger’s side corner of the engine 
bay using the two existing bolts; simple remove the bolts, position the bracket and 
reservoir and reinstall the bolts. You’ll need to trim the washer bottle fluid line to suite, 
and connect the electrical connector (Note:apparently there are two different GM 
washer pump connectors, if yours differs from the plug and play end we sent you you 
may need to cut and splice the wiring instead) 



Finish by running the ¼” hose from the throttle body spacer down to the blow off valve 
vacuum port, cut to length as needed and secure. Use the new included wiring harness 
to adapt the original MAF sensor plug to the new MAF sensor location. 

Finally you can secure the intercooler to the crash bar support. Use the included drill bit 
and tap to make threads to secure the brackets to both the topside and front side of the 
bar and secure with the provided shorter bolts. 

 

Step 13: Install Intake and Air Filter 

You’ll need to start by removing the horns from their existing location. The bracket is 
held on with three 10mm bolts, which you’ll need to access from the driver’s fender 
lining area and remove, set aside for now. 

Attach the K&N air filter to the large 45* aluminum intake elbow pipe. The 90* silicone 
coupler that attaches to the Procharger will have a shorter leg that’s a large diameter, 
this goes over the Procharger inlet. Ensuring to check clearance from the A/C line, slide 
the aluminum pipe  up from the fender-well and into the silicone 90* elbow, angling so 
the filter faces forward and has clearance. Once you’re happy with the alignment, 
tighten down the clamps. The clamps on the silicone elbow are high torque band 
clamps and can be tightened snug with a ¼” ratchet with an 8mm socket, don’t go crazy 
but they’re meant to be tightened more than a flat-blade screwdriver if you need to. 

 

 

 

 



Step 14: Install Horns and if applicable Computer Bracket 

On 2010-13 3.6 models and 2010-13 3.0 models, the engine computer and its bracket 
you previously removed will now be remounted around where the horns mounted.  

Reference the picture below, you’ll see how you can mount the bracket to two of the 
holes left from the horn bracket and secure with two nuts and bolts. Simply place the 
bracket on the surface, sliding it over as far as you can and down as you can so it sits 
flush, then mark and drill the holes. Secure the bracket with the included low profile 
button head screws and nylon lock nuts.  

 

For all models, remove the two horns from the original bracket by loosening their nuts, 
and install them on the new provided bracket, resecuring with the nuts. Loosen the 
headlight securing nut and install the bracket, resecure with the same nut. Your horns 
will now look like this… 



 



Step 15: Spark Plugs and MAP Sensor 

Use the included spark plugs to do a full plug change on your engine. The plugs come 
pregapped at .035”, it’s always recommended to double check before installing. Should 
you ever need new replacements, take note of the part numbers, they can be 
purchased at the GM dealership or any place that sells AC Delco parts. 

If you have higher mileage, consider replacing all of the ignition coils while doing the 
spark plugs, they are a moderately risk failure item as they age and a full set can be 
purchased off of Amazon or elsewhere for around $200 for the set. 

The MAP sensor is located ontop of the intake manifold towards the back. Remove its 
Torx retaining bolt and electrical connector and swap the sensors with the new 
provided, resecuring the bolt and electrical connection. 

 

Step 16: Install Catch Can System 

Your catch can will include a bunch of new preassembled hoses and the can itself with 
mounting brackets. The can can be mounted as shown off of one of the bolts on the 
brake vacuum pump (Note: picture may show older 3 port catch can). Remove the nut 
from the bottom of the right side bolt, install the bracket and reinstall the nut.  

Before installing, if you have the two port catch can, note and remember which is the In 
and which is the Out, you may find it hard to read once installed. 

 

Disconnect the line that runs from the back of the passenger’s side valve cover to the 
top of the intake manifold. There’s a tab to slide sideways and the fitting will slide up 



and off of the PCV fitting on the valve cover. Rotate the fitting on the manifold counter 
clockwise and watch for the locking tabs to be released, then it can be pulled upward.  

Locate the new line that has the same fitting for the PCV valve, click it into place on the 
valve cover fitting, then run it to the catch can and connect to the “In” port, trim the hose 
length as you desire as I try to send them slightly long. 

Locate the new line that has a silver check-valve in it; the end that the check valve is 
closest to will connect to the inlet elbow on the Procharger, it draws a vacuum source 
from it at full throttle, connect it now to fitting preinstalled on the elbow or locate the 
predrilled hole in the elbow and slide the barb fitting into the silicone elbow securely. 
Connect the other end which will have a T fitting in it to the catch can on the “Out” port.  

Locate the hose that has the same fitting in it as the intake manifold end previously 
removed, it’ll also have a check valve in it. Insert and rotate clockwise 90* to secure. 
Run the other end of that hose to the T fitting on the previously installed hose. Trim the 
hoses as you desire for a good fit. 

Locate the long hose with a short piece of larger pliable silicone hose at the end. This 
runs from the air filter neck fitting to the rear driver’s side valve cover fitting. Attach the 
pliable silicone end to the rear driver’s side valve cover fitting, ensure it’s nice and snug. 
Run as desired down to the air filter, trim at the filter end and attach to the preinstalled 
plastic barb fitting on the filter neck. 

 



Step 17: Reinstall Front Bumper 

Time to reinstall the front bumper fascia and button up the car. Refer to the original 
disassembly process, and just do everything in reverse. 

Step 18: Fill With Oil and Final Checks Under The Hood 

Using the included package of supercharger oil, add one full 6 ounce bottle of oil to your 
Procharger unit. There are bottles for subsequent oil changes and this can be 
purchased at Summit Racing, Jegs and many other performance outlets, always use 
Procharger genuine oil. 

Time to check everything you’ve installed. Look for the following items: 

- Things are clear from the serpentine belt 
- Things are clear from the exhaust downpipes 
- Intercooler piping isn’t clunking against the subframe, adjust if so to correct 
- Check all clamps are tight 
- Check that the catch can fittings connections are good  
- Check coolant level and add 
- Add fluid to the Power Steering Reservoir to the cold mark 

Step 20: Flash Tuning 

When you receive back your Overkill tune files, they’ll be labelled as Overkill or OK and 
then Supercharger. Subsequent revisions will be labelled Mod1, Mod2 etc. If you’re 
automatic transmission equipped, you’ll have your Overkill transmission settings in this 
file.  

At some point in the flash, you’ll be asked to license the vehicle and file. When the 
screen comes up, click Licensing Options, select Specific Vehicle and click ok to license 
your vehicle with the included credits. 

To flash the tune to the vehicle, open up VCM Editor, go to File > Open and select the 
tune that you wish to run. Go to Flash > Write Vehicle, and for the computer options that 
come up you’ll want to see Write Calibration selected.  



 

Turn the key or ignition to “on” or “run”, so the instrument cluster lights up, but do NOT 
start the engine. If you have a push button start, press and hold the start button with 
your foot off the brake pedal for about 10 seconds to put the vehicle into run mode. Wait 
15-20 seconds from turning the ignition on before you begin a write of any of the 
computer modules, to allow them time to boot up and run their startup system checks. 
You can now click Flash and let the system upload the tunes to your vehicle. Do not 
interrupt this process by using the computer for other things, disconnecting the cable by 
accident or otherwise, fidgeting with the stereo or hvac or etc, it is very very important 
not to interrupt the writing process, you may leave your vehicle inoperable! This is rare 
but can happen. If for any reason the flashing process is interrupted, do not turn off the 
ignition, check all your connections and try immediately to flash again, you should see 
the HP Tuner suite recover and reboot the flashing process. 

Once the flashing process is computer, and you see Write Complete for all the 
computers selected, you can turn off the ignition, wait 10 seconds, and then start your 
vehicle. If you have a push button start, turn the ignition on and then off again, you may 
find it doesn’t try to start the first time, just try again and it should fire up. 

Your vehicle will now be programmed with Overkill tuning! 

 

 



Step 4: Taking a Driving Scan 

While you’ve received your Overkill tunes programmed to your modifications, it’s always 
beneficial to take a driving scan and send that scan data to Overkill so your tune can be 
further refined as needed.  

Open the VCM Scanner, connect your laptop to the vehicle with the cable/module, start 
your vehicle up (this time its ok to use this suite while the engine is running). Go to the 
excel like table on the left side of the scanner, to the top and you’ll see a button that 
says Recent Channel Configs, click on that, Open Channel Config and select the .xml 
file that I’ve emailed with your tunes (email me back for one if you don’t see it attached).  

 

Now go to Vehicle > Connect and Vehicle > Start Scanning, confirm that you see the 
parameters on that table in the right hand column changing as it gets information from 
the computer. 

Now go ahead and drive the vehicle. Take about a 10 minute scan, nothing too short, 
try not to be overly long as the file becomes huge to try and sift through on my end, and 
include your regular driving habits, include some brief full throttle if you can such as a 
highway ramp entrance or a 0-60 run in an appropriate area, and at the end of the scan 
include about 30 seconds of idling. When finished, go to Vehicle > Disconnect, then Log 
File > Save Log File As, save it as your name and what tune you’re running (John Smith 
OKSC for example) and add the date if you choose, then email me that file to 
willoverkill@gmail.com. I’ll look at the data, revise the tune as needed and email that 
back within 5 business days. 

mailto:willoverkill@gmail.com


What’s normal and not to hear with this supercharger 

The supercharger will include lots of new noises. The Procharger itself will have a 
whirring sound and can sound a little like a rock tumbler to some; this is perfectly normal 
for these units. The blow off valve will sound like air rushing out and you’ll hear this at 
idle, decelerating or mild cruising at city driving speeds, this is normal operation for this 
valve in a supercharger setting. If you hear any knocking like a hammer, check the belt 
tension and ensure the tensioner isn’t at its furthest travels, that will typically cause that 
sound; changing belt sizes or the size of the tensioner pulley are the fixes. 

Maintenance On The Supercharger Kit 

The Procharger will require its first oil change at 500 miles, and then regular oil changes 
every 6000 miles or 1 year. Check the oil level on a regular basis in between changes. 
Use only the Procharger specific brand of oil. 

Your catch can should be drained at least every oil change or at least twice per year. 
Check it often at first if you’re unsure, you’ll get a feel for how often it fills.  

Strongly recommend the use of synthetic oil like Amsoil, Mobil 1 or Pennzoil Platinum  
in your engine, differential and transmission, with quality filters, and change at factory 
“severe service” intervals or earlier, which you’ll find specifies transmission and 
differential oil changes every 45 thousand miles. 

Should you need a new supercharger belt or a different length supercharger belt, take 
note of the part number on the belt provided, it will be a Gates belt typically starting with 
K080xxx or an AC Delco starting with 8Kxxx. The following Gates belt part numbers are 
listed from longer to shorter (larger last 3 numbers are longer, they specify the belt 
length in inches) 

K080560 > K080558 > K080553HD > K080550 > K080547 > K080545 > K080537 

Check the condition of the air filter every 6 months at least. The hydrophobic prefilter 
will aid greatly in keeping the filter clean and can be wiped off with a water damp rag. If 
the filter needs cleaning, remove from the vehicle and use the manufacturer’s 
recommended cleaning procedure. 

 

 

 

 



Warranty On Supercharger Kit 

The Procharger head unit follows the manufacturer’s warranty and guidelines, contact 
Procharger or Overkill for details as needed. The Overkill warranty on the remaining 
parts is for 1 year from date of purchase on items like the tensioner failing and making 
noise, if a silicone elbow developes a split, if the intercooler develops a crack. Items that 
aren’t covered are items that come from abuse, misinstallation, improper maintenance, 
collisions, acts of god, or from additional non kit related modifications, and can include 
for example your tires contacting the air filter at full lock and wearing a hole in it, or 
stripping out the threads in the mounting plates due to overtightening.  

This warranty covers replacement of the part only. It does not cover labor costs to 
diagnose or to remove or replace the component. It does not cover any towing costs. It 
does not cover any downtime costs on the vehicle. 

 

What If I Need A New… 

The supercharger kit has been designed with no components that will require 
extraordinary replacement schedules. There are of course items on the kit that won’t 
last forever. Here’s a list of wearable parts: 

Supercharger Belt – Take note of the Gates belt part number on your belt, write it down 
if you need to. It’ll start with a K, for example K080547. These are available from NAPA 
and elsewhere. You can also replace K080 with 8K and find the same belt under AC 
Delco (example 8K547) 

Tensioner Pulley – Dayco 89094  

Spark Plugs – AC Delco 41-147 (application 2016 Cadillac ATS-V 3.6 Turbo) 

Washer Fluid Pump – Reference a 2000 Ford Crown Victoria 

Air Filter – K&N RE-0950 and prefilter 22-8033PK 

 


